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Feature Overview 
Micro-Manager is a free, open-source microscope control software plugin based inside ImageJ. 

 

• Microscopes supported from every major brand 

• Stages, Piezos, Filter Wheels, Shutters, and more specialist hardware also supported 

• A vast library of ImageJ and Micro-Manager image analysis and acquisition plugins developed 
and maintained by a strong and diverse community of imaging users 

• Built-in macro support and ability to write custom plugins 

• Teledyne Photometrics Micro-Manager camera drivers are developed in-house so are always up 

to date with camera features well supported 

 
 

 

 

 
 

 
 

 

 

 

Histogram & Image 
Scaling Controls (LUTs) 

Image Handling, Page 33 

Easy access to hardware 
controls & custom shortcuts 
Groups & Presets, Page 17 

Live Preview, before and 
during acquisition 

Image Handling, Page 29 

ImageJ Analysis tools and 
plugins available easily 

ImageJ Functions, Page 37 

Easy Camera & Light 
Source Controls 
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Streaming to RAM 
or to disk 

Support for XY Stages 
and Tiling, and for Z / 

Piezo Stages 

Streaming Acquisition 
and Timelapse 

Movies & Timelapse, 
Page 31 

Multi-Channel 
Acquisition, Multi-
Channel, Page 31 

Save & Load 
Experimental 

Configurations 

Real time intensity graphs & ratiometric intensities, Real Time Intensity, Page 38 

…with many additional features regularly added! 
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How to Get Started 
Welcome to this guide on how to use Micro-Manager software with Teledyne Photometrics cameras! 

Below are our suggested steps for how to begin using Micro-Manager to make the most of your camera. 

 

1. Install your camera onto the microscope and connect it, and any other 

hardware, to the computer. 

 

2. Download and install PVCAM Drivers (see Page 6) 

 

3. Download and install Micro-Manager (see Page 7) 

 

4. Download or create a Hardware Configuration File to tell 

Micro-Manager what hardware you’ll be using (see Page 9) 

 

5. Go ‘Live’ and start imaging! 
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Installation 

Download and Install PVCAM Drivers  
The first step to installing your Teledyne Photometrics camera is to download the latest PVCAM drivers 

from our website. Here is a link: 

 

1. Visit: https://www.photometrics.com/support/software-and-drivers 
 

Or alternatively, visit www.photometrics.com and click ‘Support’, then ‘Software Downloads and 

Drivers’. 

 

 
 

2. Specify which camera you are using and which operating system. The website will then 

recommend the appropriate driver version. Click the ‘Recommended Driver’ link. 

 

 
  

https://www.photometrics.com/support/software-and-drivers
http://www.photometrics.com/
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3. You will be invited to fill out a form to immediately receive a link via email to download our driver 

set in a .zip file. Download and extract this, and run the .exe file contained inside: 

4. Run the installer. 

 

Note: If your camera has a USB or PCIe interface and 
does not run on the older Firewire interface, but you do 

have other firewire hardware such as older microscopes 

or devices, uncheck the two drivers containing ‘1394’, as 

these may conflict with other firewire devices. If you have 
no firewire devices, you do not need to change anything. 

 

5. Connect your camera power and data cables as directed 

in the camera manual. 
 

Download and Install Micro-Manager 
Micro-Manager has an enormous array of versions available. However, at any one time there is likely only 

one recommended version, that being the latest nightly build of Micro-Manager 2.0.1 (the current version 

at the time of writing).  

 
For some hardware and plugins other versions may be required; please see the support pages for your 

hardware. 

 

To download Micro-Manager: 
1. Open the Micro-Manager website at https://micro-manager.org/, or skip to Step 4 by following 

the link below: 

 

https://download.micro-manager.org/nightly/2.0/Windows/  
 

 
 

2. Click ‘Downloads’ (https://micro-manager.org/Download_Micro-Manager_Latest_Release)  
 

 

 

https://micro-manager.org/
https://download.micro-manager.org/nightly/2.0/Windows/
https://micro-manager.org/Download_Micro-Manager_Latest_Release
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3. Scroll down to and click the link for Micro-Manager 2.0.0 (Windows 64-bit). The software will 

start to download. This version is the latest stable version of Micro-Manger as of July 2021. 

 

 
 

4. Alternatively, if you wish to use the latest nightly build, access the menu to the right of the page 

and select ‘Nightly Builds’, then select ‘Version 2.0 (Windows)’. The topmost link will be the 

latest released version for 64-bit computers. Click this to download, and run the installer. 
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Creating A Hardware Configuration File 
Micro-Manager can be configured to control a very wide array of microscopy and other imaging hardware. 

When you first open Micro-Manger you will need to create a ‘Hardware Configuration File’ where you tell 

Micro-Manager what imaging hardware you are using (camera, microscope, motorized stages, light 

sources, etc.) so you can control it all through Micro-Manager.  
 

Hardware Configuration Files are created and edited via the Hardware Configuration Wizard. On your 

first time opening Micro-Manager you’ll need to create the config file, but every subsequent time you use 

the software this file will be pre-loaded and ready to go. You can also modify existing files, such as adding 
a new piece of hardware. 

 

Creating a new Hardware Configuration File 

1. Make sure your camera and any additional imaging hardware is powered on, turned on, and 
successfully connected to the computer. 

2. Open Micro-Manager, and when prompted for a Hardware Configuration File, select ‘(none)’. 

 
3. When the Micro-Manager window opens, go to ‘Devices’, choose ‘Hardware Configuration 

Wizard’. 
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4. Select ‘Create new configuration’. 

 
5. On the following page you can add or remove imaging hardware. In order to control the camera, 

light source etc., they will need to be added to this list for Micro-Manager to recognize. 

a. Under ‘Available Devices’ is an alphabetical list of imaging hardware vendors. Find your 

device folders and select ‘Add’, where you will be prompted to name the device, at which 
point it will be added to Micro-Manager. 

b. Most devices have an online help and installation guide, which can be found through 

selecting the device and clicking ‘Help’. 

c. Teledyne Photometrics cameras are listed under the driver set ‘PVCAM’. There are up to 
four camera slots that you can use. If you have only one camera connected, this will 

always be ‘Camera-1’. 

 
6. Once you have added all your necessary imaging hardware, advance the wizard. Some hardware 

may have further configuration steps; for PVCAM Cameras, no further steps are necessary! 

7. The final step will invite you to name and save your Hardware Configuration File. This will be 
saved by default to the Micro-Manager installation folder within C:\Program Files, and will be 

pre-selected every time you use Micro-Manager. You can make a number of different config files 

for different imaging setups, just make sure you know where they are saved. 
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Installing other microscope hardware 

Light Sources 

Micro-Manager can control light sources from many manufacturers. Some example installation guides 

are linked below: 

CoolLED pE300, pE340 and pE4000 Light Sources 

Please see the guide linked below for instructions on driver installation. This also discusses the creation 

of shortcuts to necessary settings (‘Groups’) and the use of the light source for multi-channel acquisition. 

https://www.coolled.com/technical-resources/videos/micro-manager-for-pe-300-series-and-pe-

340fura/#pe-400016122586602461612263176353  

Lumencor SPECTRA, SPECTRA X, AURA and CELESTA Light Engines 

Instructions to connect these light sources can be found here: 

https://micro-manager.org/wiki/LumencorSpectra 

Other Hardware 

For a list of supported hardware in Micro-Manager, complete with installation guides for devices, please 

see the following web page: 

https://micro-manager.org/wiki/Device%20Support 

For some hardware, additional files and drivers may be needed from the device manufacturer. Please see 
the website for your device manufacturer or contact their support teams. 

Which Hardware Is On Which Port? 
Please note, whenever adding any hardware to Micro-Manager using USB interfaces, you will need to 

check which COM port each device is assigned to in order for them to function as intended. To find out 
which device is connected to which COM port please refer to the ‘Device Manager’ in Windows: 

1. In Windows, right click the start button and select ‘Device Manager’
2. Look at ‘Ports (COM & LPT)’ in the Device Manager to see your connected hardware (if connecting 

them via USB)
3. In order to determine which device is on which port you may need to unplug the device and then 

go to ‘Action’ and ‘Scan for hardware changes’ to see which device is no longer present.
4. Once you know which device is on which COM port, select this port when adding the device to 

Micro-Manager

https://www.coolled.com/technical-resources/videos/micro-manager-for-pe-300-series-and-pe-340fura/#pe-400016122586602461612263176353
https://www.coolled.com/technical-resources/videos/micro-manager-for-pe-300-series-and-pe-340fura/#pe-400016122586602461612263176353
https://micro-manager.org/wiki/LumencorSpectra
https://micro-manager.org/wiki/Device%20Support
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Adding a Manual Objective Turret 

Micro-Manager supports automated objective turrets for many microscopes. However, for manual 

microscopes, a manually changed objective or magnification indicator can be added in, which can be used 

to record which objective was used, and provide automatically updating pixel scaling information. 
 

Adding a Manual objective magnification indicator 

1. In the Available Devices list on the Hardware Configuration Wizard, locate the ‘DemoCamera’ 

folder and add ‘DHub’. 

 
2. A Peripheral Devices Setup window will then appear – within this, select ‘DObjective’. This will 

add a dummy/demo objective to the device configuration. The same can be done for the other 

components in the peripheral list. 

 
3. Advance to Step 5 of 6, where you can set the label for each of your objectives according to their 

magnification, NA etc. 

 
4. Finish the wizard and add a group for ‘Objective’ as described in Groups and Presets on Page 17. 

5. You can now set up Pixel Scaling Information following the instructions on Page 21. 
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Running two or more PVCAM Cameras Simultaneously 
Micro-Manager is capable of running up to 4 PVCAM cameras simultaneously. The only requirement is that 

the cameras have the same sensor size or region of interest applied, and the same bit depth of resulting 

images. 

 
The below guide is for the specific case where the cameras will be run simultaneously; if you want to install 

and access multiple cameras without simultaneous use, follow only steps 1, 2 and 6. 

 

 
How to set up multiple cameras in Micro-Manager 

1. Creating a new configuration file or editing an existing one, and add in each of the Camera-1, 

Camera-2 etc. PVCAM camera slots that you are using and name them appropriately. 

 

  
 

2. These should all appear in the Installed Devices list with a status of ‘OK’
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3. Now we add in a special ‘Multi Camera’ Utility to treat multiple cameras as one multichannel 

camera device for simultaneous acquisition. Go to the ‘Utilities’ folder and add ‘Multi Camera’. 

 
4. Now finish off your Hardware Configuration File. 

5. Once your file is completed and loaded, you may see a ’Circular buffer can’t be started’ error, 
ignore this, as we need to inform the Multi Camera utility which devices to use. Go to ‘Devices’, 

open ‘Device Property Browser’ and find ‘Multi Camera-Physical Camera 1’. Choose the 

appropriate camera for each of these labelled 1 through 4. 
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6. Now create a Group for Core-Camera as described in ‘Groups and Presets’ on Page 17. 

 

 
 

7. Select ‘Multi Camera’ in your Camera group to view simultaneous output. 

 
 

8. Hit ‘Live’ to image in multiple colors simultaneously. You may need to set up your image display 

settings to view a composite image. In the Inspect window under ‘Histograms and Intensity 

Scaling’, choose ‘Color Mode: Composite’. 

9. Choose the appropriate color for each channel by clicking the rectangle next to the eye symbol 
for each histogram, shown below in green and red. The eye symbol will toggle that channel’s 

visibility. 
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Using a Single-Camera Splitter for Simultaneous Multichannel 
Micro-Manager also supports using single camera splitters, where separate wavelengths are directed onto 

separate portions of a single camera sensor. Any combination of horizontal and vertical splits is possible, 

splitting each dimension 2, 3 or 4 ways. Commonly a 2-way or 3-way vertical split, or a combined 2-way 

vertical and 2-way horizontal split is used. 
 

For advice on how to align splitting devices, please see manufacturers’ instructions or our guide: 

 

https://www.photometrics.com/products/imaging-splitters/how-to-align-a-splitter 
 

Setting up single-camera splitters 

1. Align your splitter according to manufacturer’s instructions. In the case of a 2-way or 3-way 

single direction split, for rolling shutter cameras it is most advantageous to align the channels 
vertically as shown below (left). 

2. In Micro-Manager, open ‘Plugins  On-The-Fly Image Processing  Split View’ to add one 

direction of split, specifying how many times the view is split in this dimension, as shown below 

(center, top). 
3. To add further splits in the opposing direction, in the ‘On-The-Fly Processor Pipeline’ Window, 

click ‘Add’ and select ‘Split View’. 

4. Hit ‘Live’ to image in multiple colors simultaneously. You may need to set up your image display 

settings to view a composite image. In the Inspect window under ‘Histograms and Intensity 
Scaling’, choose ‘Color Mode: Composite’. 

5. Choose the appropriate color for each channel by clicking the rectangle next to the eye symbol 

for each histogram, shown below in green and red. The eye symbol will toggle that channel’s 

visibility. 

 

 

https://www.photometrics.com/products/imaging-splitters/how-to-align-a-splitter
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Hardware Setup 

Groups and Presets: Shortcuts to key settings 
In Micro-Manager, we can make shortcuts to any hardware controls that will be frequently used. These are 

called ‘Groups’ and drastically increase your imaging efficiency, as everything you need to control about 

your imaging setup can be accessed all in one place. Each Group can control a single setting (such as 

camera gain) or multiple (which filter wheel is in the light path). 
 

 

Take note that the Micro-Manager window already has some basic imaging settings, namely exposure 

time (in milliseconds), binning, light source shutter, and establishing a region of interest (ROI). 

Single Setting Groups 

Single setting groups will provide direct access to a hardware control, such as a camera readout mode, 
light source intensity, or microscope objective turret position. Most groups you make will likely be single 

setting groups. 

 

Creating a Single Setting Group 
 

1. Click the plus button next to ‘Group’ in order to add a new group. If you want to remove or edit a 

group, use the minus and edit buttons respectively (but not the buttons to the right in the Preset 

section) 
 

 

  

Single setting 
groups directly 
show hardware 

settings 

Multi-setting 
groups allow 

selection among 
created presets 
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2. The Group Editor menu will appear, showing a list of every setting for all available hardware, listing 

each piece of hardware in alphabetical order (depending on how you named the hardware when 

using the Hardware Configuration Wizard). 

 
3. Find the setting that you want and check the box next to it. Be sure to only select one setting at 

a time. 

4. Give the group a name that makes sense to you (‘Fan speed’ for a group that controls camera 

fan speed, for example), and click OK. 

 
5. You will now have a group that allows you to directly change that hardware setting. 

 
6. Add a Group for every setting you want to be able to change when imaging. 
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Multi-Setting Groups (Example: Channels Group) 

Sometimes changing a hardware state in the system requires multiple individual components to be 
changed. For example, to change the illumination channels on your light source you’ll need to select 

multiple settings such as the ‘Violet’ and ‘Cyan’ channels in order to switch between them, and not have 

both active at the same time. This is where multiple-setting groups come in. 

 
In Micro-Manager, we can create groups that control multiple settings, and then create presets that 

specify the value of each setting. In the case of the Channel group, we would create one preset per 

wavelength channel – Brightfield can also be included if your microscope has computer-controllable 

brightfield lamp and shutters. 
 

Creating a multi-setting group 

1. Click the plus button next to ‘Group’ in order to add a new group. 

2. Identify the settings you want to change in the Group Editor menu, and then select every box 
next to all the hardware settings that need to change. In this case, each different wavelength 

channel you want to use from your light source. 

 
3. Give this group a name that makes sense and click OK. This multi-setting group will require 

several presets in order for you to control each setting within the group. When you click OK, the 

‘Preset Editor’ window will appear. 
a. Each preset is a setting within the group, for example if your group contains multiple 

illumination channels, each preset would have one channel on and all the other channels 

off. Switching between these presets would then cycle between the illumination channels. 
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4. Make the first preset for this group in the preset editor window. – note, changing settings here 

will change the physical hardware state, so be aware parts may move or activate. 

 
5. Once your first preset is created, you’ll be back at the Micro-Manager window. Select the 

multi-setting group you created, and then click the plus button in the Preset controls (next to the 
group controls) to add a new Preset for all remaining options required. 

 

 

Startup Configuration Settings 

When Micro-Manager is closed, the values in the Groups list and in the Device Property Browser are not 

stored, they will go to their default values the next time Micro-Manager is loaded. 

 
To avoid this and specify which values your settings should be on startup, or even on shutdown, 

Micro-Manager has a special Group called ‘System’. 

 

How to set default startup parameters for hardware 
1. Create a new Group as described above, called 

‘System’. Select every hardware option that you 

would like to set a Startup or Shutdown value for.  

2. In the preset editor, for Startup values name the 
preset ‘Startup’, and set the values. 

3. To add a Shutdown preset, create a new preset as 

described above, naming it ‘Shutdown’, and set 

the values appropriately. 
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Pixel Scaling Calibration 
To allow XY scaling information in images and the inclusion of scale bars, you must set up your Pixel Size 

Calibration. This requires either a manual objective turret to be included in your Hardware Configuration 

File as described on Page 12, or an automated objective turret controlled in Micro-Manager.  

 
How to set up Pixel Scaling Calibration 

1. Under ‘Devices’, select ‘Pixel Size Calibration’. In the window that appears, select ‘New’. 

 
 

2. The Pixel Size Preset Editor shown below will then appear, where all hardware that affect 

magnification (objectives, optivars, multiple cameras) can be selected though ticking the ‘Use in 

Group’ checkbox. 
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3. Set an initial value for a pixel configuration (for example, setting your Objective turret to ‘10x’), 

and give this pixel configuration a corresponding name “10x”. 

4. Calculate and enter the resulting image pixel size in micrometers based on the following formula, 
including any C-mount / optical tube magnification in the system: 

 

𝑰𝑰𝑰𝑰𝑰𝑰𝑰𝑰𝑰𝑰 𝑷𝑷𝑷𝑷𝑷𝑷𝑷𝑷𝑷𝑷 𝑺𝑺𝑺𝑺𝑺𝑺𝑺𝑺 =  
𝑪𝑪𝑪𝑪𝑪𝑪𝑪𝑪𝑪𝑪𝑪𝑪 𝑷𝑷𝑷𝑷𝑷𝑷𝑷𝑷𝑷𝑷 𝑺𝑺𝑺𝑺𝑺𝑺𝑺𝑺

𝑶𝑶𝑶𝑶𝑶𝑶𝑶𝑶𝑶𝑶𝑶𝑶𝑶𝑶𝑶𝑶𝑶𝑶 𝑴𝑴𝑴𝑴𝑴𝑴𝑴𝑴𝑴𝑴𝑴𝑴𝑴𝑴𝑴𝑴𝑴𝑴𝑴𝑴𝑴𝑴𝑴𝑴𝑴𝑴× 𝑨𝑨𝑨𝑨𝑨𝑨𝑨𝑨𝑨𝑨𝑨𝑨𝑨𝑨𝑨𝑨𝑨𝑨𝑨𝑨 𝑴𝑴𝑴𝑴𝑴𝑴𝑴𝑴𝑴𝑴𝑴𝑴𝑴𝑴𝑴𝑴𝑴𝑴𝑴𝑴𝑴𝑴𝑴𝑴𝑴𝑴
 

 

You can find your camera pixel size on the Camera Specification Sheet, or in the following table: 

 

Camera Pixel Size 

Kinetix 6.5 μm 

Prime 95B 11.0 μm 

Prime BSI / BSI Express 6.5 μm 

Iris 4.25 μm 

Retiga E7 4.5 μm 

Retiga E20  

Moment 4.5 μm 

Evolve 10 10 μm 

Evolve 13 13 μm 

Evolve 16 16 μm 

Retiga R6/LUMO/ELECTRO 4.54 μm 
 

5. Once you have inserted your pixel size, click ‘Calculate’. Alternatively, if you have a correctly 

calibrated, motorized XY stage installed into Micro-Manager you can click ‘Measure’ for an 

automated measurement of pixel size. 
6. Click ‘OK’, and then repeat the process for all remaining objectives, or permutations of different 

magnification-adjusting hardware. 

 
7. Once you have finished adding these, click ‘Close’ and you will be prompted to save the changes 

you have made into the Hardware Configuration File. 
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Controlling Teledyne Photometrics Cameras 

Important Groups & Optimal Camera Settings 

Kinetix Family 

 Camera Setting Setting Name in list Values 

E
ss

e
n

ti
al

 

Mode – Change between 

the four imaging modes of 

the Kinetix. This changes 

both the readout and gain, 

which are optimized for 

each mode. 

Port ‘Speed’ – 8-bit, 498 fps across full sensor 

‘Sensitivity’– 12-bit, 88 fps across full sensor, low 

read noise mode at speed 

‘Dynamic Range’ – 16-bit, 83 fps across full 

sensor, large full well capacity for imaging intense 

signals 

‘Sub-Electron’ – 16-bit, 5 fps across full sensor, 

ultra-low read noise of 0.7 e-  

R
e

c
o

m
m

e
n

d
e

d
 

Metadata – Additional 

hardware metadata 

including Timestamps 

MetadataEnabled ‘Yes’ – Add additional hardware metadata 

including a 10ns precision timestamp for the 

beginning and end of each frame – see Page 28. 

Fan Speed – Control over 

air cooling fan speed 

FanSpeedSetpoint ‘Low’ – For air cooling for typical (< 2 seconds) 

exposure times and room temperatures, camera 

airflow unobstructed. 

‘High’ – Air cooling with long exposures or in 

confined or warm environments 

‘Off’ – Use only when water cooling is in use 

T
ri

g
g

e
ri

n
g

 

Trigger In – Hardware 

trigger to control camera 

acquisition 

TriggerMode ‘Internal’ – Camera runs on own internal timing 

as defined by software. Other modes allow 

external control of camera. Please see camera 

manual for explanation of other trigger modes. 

Expose Out Trigger 

Behavior 

ExposeOutMode Used when synchronizing external hardware 

through hardware triggering. Please see camera 

manual for explanation of the options. 

Number of Expose Out 

Cables Used 

Trigger - ExposeOutMux If using Multi Expose Outs to trigger multiple light 

sources etc., how many cables to use 

A
d

va
n

ce
d

 

SMART Streaming Enable – 

Use for faster sequential 

multi-channel acquisitions 

with channel-dependent 

exposure times 

SMARTStreamingEnabled ‘No’ – Don’t use SMART Streaming 

‘Yes’ – Use SMART Streaming. 

Please see camera manual for instructions on 

SMART Streaming and when to use it. 

SMART Streaming 

Exposure Times – list of 

exposure times to use for 

above feature 

SMARTStreamingValues List of exposure times to use, separated by 

semicolons ; 
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Prime 95B 

 Camera Setting Setting Name in list Values 

E
ss

e
n

ti
al

 

Readout Mode – Main 

camera mode setting 

ReadoutRate ‘200MHz 12 Bit’ - Low light / high speed imaging 

‘100MHz 16 Bit’ - High dynamic range imaging 

Gain – Conversion factor 

between photoelectrons 

signal and grey levels 

displayed 

Gain – Create this group 

after setting ‘Readout 

Rate’ to ‘200MHz 12 Bit’ 

For practically all low-light or fluorescence 

imaging: ‘3-Sensitivity’ 

For brightfield imaging: 

‘1-Full Well’ or ‘2-Balanced’ 

Clearing – Antiquated 

setting regarding charge 

clearance 

ClearMode ‘Never’ – For all imaging. Other settings may 

introduce framerate and timing delays. This may 

require setting on startup. 

R
e

c
o

m
m

e
n

d
e

d
 

Metadata – Additional 

hardware metadata 

including Timestamps 

MetadataEnabled ‘Yes’ – Add additional hardware metadata 

including a 10ns precision timestamp for the 

beginning and end of each frame – see Page 28. 

Fan Speed – Control over 

air cooling fan speed 

FanSpeedSetpoint ‘Low’ – For air cooling for typical (< 2 seconds) 

exposure times and room temperatures, camera 

airflow unobstructed. 

‘High’ – Air cooling with long exposures or in 

confined or warm environments 

‘Off’ – Use only when water cooling is in use 

T
ri

g
g

e
ri

n
g

 

Trigger In – Hardware 

trigger to control camera 

acquisition 

TriggerMode ‘Internal’ – Camera runs on own internal timing 

as defined by software. Other modes allow 

external control of camera. Please see camera 

manual for explanation of other trigger modes. 

Expose Out Trigger 

Behavior 

ExposeOutMode Used when synchronizing external hardware 

through hardware triggering. Please see camera 

manual for explanation of the options. 

Number of Expose Out 

Cables Used 

Trigger - ExposeOutMux If using Multi Expose Outs to trigger multiple light 

sources etc., how many cables to use 

A
d

va
n

ce
d

 

SMART Streaming Enable – 

Use for faster sequential 

multi-channel acquisitions 

with channel-dependent 

exposure times 

SMARTStreamingEnabled ‘No’ – Don’t use SMART Streaming 

‘Yes’ – Use SMART Streaming. 

Please see camera manual for instructions on 

SMART Streaming and when to use it. 

SMART Streaming 

Exposure Times – list of 

exposure times to use for 

above feature 

SMARTStreamingValues List of exposure times to use, separated by 

semicolons ; 
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Prime BSI & Prime BSI-Express 

 Camera Setting Setting Name in list Values 

E
ss

e
n

ti
al

 

Readout Mode – Main 

camera mode setting 

ReadoutRate ‘200MHz 12 Bit’ - Low light / high speed 

imaging 

‘100MHz 16 Bit’ - High dynamic range imaging 

Gain 100MHz – Conversion 

factor between 

photoelectrons signal and 

grey levels displayed 

Gain – Create this group 

after setting ‘Readout 

Rate’ to ‘100MHz 16 Bit’ 

(both modes required) 

‘CMS’ – Recommended for all low light imaging. 

Low read noise mode. 

‘HDR’ – For imaging bright and dark things 

simultaneously. Maximum dynamic range. 

Gain 200MHz – 

Conversion factor between 

photoelectrons signal and 

grey levels displayed 

Gain – Create this group 

after setting ‘Readout 

Rate’ to ‘200MHz 11 Bit’ 

(both modes required) 

For practically all low-light or fluorescence 

imaging: ‘3-Sensitivity’ 

For brightfield imaging: 

‘1-Full Well’ or ‘2-Balanced’ 

R
e

c
o

m
m

e
n

d
e

d
 

Metadata – Additional 

hardware metadata 

including Timestamps 

MetadataEnabled ‘Yes’ – Add additional hardware metadata 

including a 10ns precision timestamp for the 

beginning and end of each frame – see Page 28. 

Fan Speed – Control over 

air cooling fan speed 

FanSpeedSetpoint ‘Low’ – For air cooling for typical (< 2 seconds) 

exposure times and room temperatures, camera 

airflow unobstructed. 

‘High’ – Air cooling with long exposures or in 

confined or warm environments 

‘Off’ – Use only when water cooling is in use 

T
ri

g
g

e
ri

n
g

 

Trigger In – Hardware 

trigger to control camera 

acquisition 

TriggerMode ‘Internal’ – Camera runs on own internal timing 

as defined by software. Other modes allow 

external control of camera. Please see camera 

manual for explanation of other trigger modes. 

Expose Out Trigger 

Behavior 

ExposeOutMode Used when synchronizing external hardware 

through hardware triggering. Please see camera 

manual for explanation of the options. 

Prime BSI Only 

Number of Expose Out 

Cables Used 

Trigger - ExposeOutMux If using Multi Expose Outs to trigger multiple 

light sources etc., how many cables to use 

A
d

va
n

ce
d

 

Prime BSI Only 

SMART Streaming Enable – 

Use for faster sequential 

multi-channel acquisitions 

with channel-dependent 

exposure times 

SMARTStreamingEnabled ‘No’ – Don’t use SMART Streaming 

‘Yes’ – Use SMART Streaming. 

Please see camera manual for instructions on 

SMART Streaming and when to use it. 

Prime BSI Only 

SMART Streaming 

Exposure Times – list of 

exposure times to use for 

above feature 

SMARTStreamingValues List of exposure times to use, separated by 

semicolons ; 

 

  



 

 

 
 

Rev A4      ©2023 Photometrics. All rights reserved.  

How to use Micro-Manager 
 

 

26 

 

Iris Family 

 Camera Setting Setting Name in list Recommended Value 

R
e

c.
 Metadata – Additional 

hardware metadata 

including Timestamps 

MetadataEnabled ‘Yes’ – Add additional hardware metadata 

including a 10ns precision timestamp for the 

beginning and end of each frame – see Page 28. 

T
ri

g
g

e
ri

n
g

 

Trigger In – Hardware 

trigger to control camera 

acquisition 

TriggerMode ‘Internal’ – Camera runs on own internal timing 

as defined by software. Other modes allow 

external control of camera. Please see camera 

manual for explanation of other trigger modes. 

Expose Out Trigger 

Behavior 

ExposeOutMode Used when synchronizing external hardware 

through hardware triggering. Please see camera 

manual for explanation of the options. 

A
d

va
n

ce
d

 

SMART Streaming Enable – 

Use for faster sequential 

multi-channel acquisitions 

with channel-dependent 

exposure times 

SMARTStreamingEnabled ‘No’ – Don’t use SMART Streaming 

‘Yes’ – Use SMART Streaming. 

Please see camera manual for instructions on 

SMART Streaming and when to use it. 

SMART Streaming 

Exposure Times – list of 

exposure times to use for 

above feature 

SMARTStreamingValues List of exposure times to use, separated by 

semicolons ; 

Retiga E Family 

 Camera Setting Setting Name in list Recommended Value 

E
ss

 

Readout Mode – Main 

camera mode setting 

ReadoutRate ‘Speed’ – High-speed imaging 

‘Long Exposure’ – Ultra-low dark current mode, 

allowing for exposures of up to 60 minutes 

‘Long Exposure EDR’ – Ultra-low dark current 

mode with Extended Dynamic Range (EDR) to 

increase full-well capacity 

R
e

c.
 Metadata – Additional 

hardware metadata 

including Timestamps 

MetadataEnabled ‘Yes’ – Add additional hardware metadata 

including a 10ns precision timestamp for the 

beginning and end of each frame – see Page 28. 

T
ri

g
g

e
ri

n
g

 

Trigger In – Hardware 

trigger to control camera 

acquisition 

TriggerMode ‘Internal’ – Camera runs on own internal timing 

as defined by software. Other modes allow 

external control of camera. Please see camera 

manual for explanation of other trigger modes. 

Expose Out Trigger 

Behavior 

ExposeOutMode Used when synchronizing external hardware 

through hardware triggering. Please see camera 

manual for explanation of the options. 
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Moment CMOS 

 Camera Setting Setting Name in list Recommended Value 

R
e

c.
 Metadata – Additional 

hardware metadata 

including Timestamps 

MetadataEnabled ‘Yes’ – Add additional hardware metadata 

including a 10ns precision timestamp for the 

beginning and end of each frame – see Page 28. 

T
ri

g
. 

Trigger In – Hardware 

trigger to control camera 

acquisition 

TriggerMode ‘Internal’ – Camera runs on own internal timing 

as defined by software. Other modes allow 

external control of camera. Please see camera 

manual for explanation of other trigger modes. 

 

 

CCD Family: Retiga R6, Retiga ELECTRO, Retiga LUMO, MicroPublisher 6 

 Camera Setting Setting Name in list Recommended Value 

E
ss

e
n

ti
al

 Clearing – Antiquated 

setting regarding charge 

clearance 

ClearMode ‘Clear Pre-Sequence’ – Achieve full speed of 

acquisition, for streaming / snap applications 

‘Clear Pre-Exposure’ – Remove excess charge 

between frames, for time-lapse imaging 

T
ri

g
g

e
r Trigger In – Hardware 

trigger to control camera 

acquisition 

TriggerMode ‘Internal’ – Camera runs on own internal timing 

as defined by software. Other modes allow 

external control of camera. Please see camera 

manual for explanation of other trigger modes. 
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Advanced Features 

Hardware Timestamps 

Many cameras from Teledyne Photometrics are able to provide highly accurate and precise hardware 

timestamps, generated on the camera’s onboard intelligence. This will be the most precise timestamp 

available for when an image was taken. These can be enabled within Micro-Manager, and will then be 
included in all streaming (i.e., anything but pressing ‘Snap’) acquisitions. 

 

How to enable and view Hardware Timestamps 

1. In Device Property Browser or by creating a group, find the property 
‘[Camera Name]-MetadataEnabled’, and select ‘Yes’. 

 

 
 

2. Now each acquired image will show additional metadata under the ‘Image Plane Metadata’ tab 

of the Inspect window, starting with “PVCAM-FMD” (“Frame Meta Data”).  

3. This metadata includes many additional items, the hardware timestamps are under the name 

“PVCAM-FMD-TimestampBofNs” and “…EofNs”, meaning “Beginning of frame, Nanoseconds” 
and “End of frame” respectively. These two times will differ by the frame roll time for rolling 

shutter cameras, and are in units of 1 ns, with 100 ns precision and 1 line time accuracy (10-20 μs, 

depending on camera speed). 
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Regions of Interest 
To create a region of interest in Micro-Manager, use the ImageJ rectangle tool to draw on a live or snapped 

image, and click the blue ‘ROI’ button outlined below (left red box). To return to the full field of view, click 

the four green arrows button (right red box). 

 
 

Specifying ROI sizes & positions 

To specify an exact size and position of region of interest, use Edit  Selection  Specify… within 

ImageJ to specify Width, Height and X and Y co-ordinate of the top left corner. The ‘Centered’ option 

would instead make the reference point for the X and Y co-ordinate the center of the ROI. 
 

 
You can also save selections to ImageJ’s ROI Manager to save them to a file and load them by dragging 

and dropping the file onto ImageJ, or to select between multiple ROIs. 
 

Once you have drawn up your chosen ROI, click the blue ROI button outlined above to apply it to the 

camera. 

Multi-ROI 

Some Teledyne Photometrics cameras support Multi-ROI, allowing up to 16 regions to be imaged 

simultaneously. The overall camera readout and image size will then be determined by the bounding box 
containing all ROIs – the camera will not skip rows not contained within an ROI. The rest of the image will 

be set to a greyscale value of ‘0’, which when used with lossless compression can significantly reduce file 

sizes, and lead to easier segmentation. 

 
Note: Multi-ROI support requires a compatible camera and Micro-Manager version 2.0 – Micro-Manager 
version 1.4 is not compatible with this feature.  
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How to set up Multiple Regions of Interest 

1. Draw your first region of interest as normal 

2. Hold shift, and begin drawing the second ROI from the top left corner. With shift held, the ROI 
will be constrained to a square. 

3. Release shift without releasing the mouse button to draw rectangular ROIs. 

4. Release the mouse button, and repeat for all further required ROIs. Note: it is permitted for ROIs 

to overlap. 
 

 

5. Should you wish to store the ROI locations for future acquisitions, at this stage, you are able to 
press ‘Ctrl+T’ to add this multi-part ROI to the ROI Manager, where it can then be recalled if lost, 

or saved for future use.  

6. Press the blue ‘ROI’ button to apply the regions.  

 

  

5. Press blue ‘ROI’ button to apply. 

1. Draw first ROI 

2. Holding shift, begin 
drawing 2nd ROI. 
3. Release shift to draw 
shapes other than squares 

4. Release mouse button. 
    Repeat. 
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Multi-Dimensional Acquisitions: Movies, Multi-Channel, Z-
stacks, XY Positions 
Acquiring more than one frame in Micromanager is handled via the Multi-Dimensional Acquisition window 

(‘Multi-D Acq.’). This is where you can design experiments with whatever hardware you have connected – 

multi XY positions, Z positions, multi-channel, and of course time points for both streaming and timelapse 

acquisition. There is also the option for autofocus at designated times. 
 

The Acquisition Order dropdown provides control over what order changing hardware parameters 

happens. For example, whether each wavelength channel is imaged sequentially on each z-slice (desirable 

for best co-localization), or whether the entire z-stack is acquired before changing between channels 
(desirable if changing wavelength channels involves time-consuming filter wheel or dichroic changes). 

 

Setting up multiple XY Positions and Z stacks is intuitive and straight forward, but not covered in this 

guide. Information can be found on the Micro-Manager website here:  
https://micro-manager.org/wiki/Micro-Manager_User%27s_Guide#Recording_Images  

Movies & Timelapse 
To acquire a movie/streaming acquisition where the camera runs at full speed (or according to external 

triggering control), simply set the number of frames you wish to acquire under ‘Time Points  Count’, 

and leave ‘Interval’ at 0. 

 
 

 

To acquire a timelapse where there is a delay between frames/stacks (including where appropriate 
multiple channels, xy & z positions), the ‘Interval’ corresponds to the target time between acquisitions, 

not to any additional added time between frames. If this interval is set shorter than the acquisition time 

per time point, it is ignored.  

 
  

https://micro-manager.org/wiki/Micro-Manager_User%27s_Guide#Recording_Images
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Multi-Channel 
To set up a multi-channel acquisition, ensure you have set up your Channel group as outlined on Page 19.  

 

How to set up a Multi-Channel Acquisition 

1. Specify your channel group that controls channel hardware in the ‘Channel Group’ box. 
2. Click ‘New’ to add a channel to the list to be acquired.  

3. Under ‘Configuration’ specify which preset value of the Channel group this channel should have. 

You can set the exposure time for this channel, whether to include a z positioning offset correction, 

whether to include this channel in Z-stacks, whether to skip a certain number of time points before 
acquiring this channel, and finally the color the channel should appear. 

 

 
4. Repeat this for as many channels as you intend to acquire.  

 

Saving Multi-Dimensional Acquisitions 
By default, with ‘Save Images’ unchecked, images are acquired into RAM as usual and can be saved after 

acquisition. 

 
To save to hard disk/SSD as images are acquired, check the ‘Save Images’ checkbox and specify a folder 

and filename. As with saving after acquisition a choice between Separate Image Files and Image Stack 

File is provided – Image Stack Files save faster, and hence are highly recommended for streaming 

acquisitions. 
 

You will need to make sure that your computer has high enough hard disk / SSD write speed to keep up 

with the data rate of the camera for high-speed streaming to disk. 
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Image Handling 

Histogram Control: Changing your image display scaling settings 
After you go ‘Live’ with a camera or acquire some images, the ‘Inspect’ window will appear in 

Micro-Manager. This window allows you to inspect your images, both as they stream live and after you’ve 

acquired them. The main part of the inspection window is the histogram, which gives a quick overview of 

the intensity information in the image. The x-axis are the possible signal intensity values, from 0 to the 
maximum value (255 for 8-bit, 4095 for 12-bit, and 65535 for 16-bit)., and the y-axis shows how many 

pixels are at each intensity level. 

 

 
 

It should be noted that for fluorescence or low-light imaging of sensitive samples, the signal intensity from 
the sample will be far lower than the maximum value the camera can display. In the example histogram 

above the camera can display intensities of up to 4095, but the highest signal from the sample is at 1128. 

The large peak at the left of the histogram (red square) represents all the black background pixels where 

there is no sample present, the area in the green square represents the pixels of the sample, displaying a 
range of intensities. 

 

By changing the histogram and scaling controls you can determine how your acquired data is displayed 

on your screen. Please note that this doesn’t change the signal intensity from your sample, just how this 
data appears on your screen. 
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How to set up scaling in Micro-Manager 

By default, automatic image scaling is used to set the maximum and minimum displayed intensity values 

based on image data. In Micro-Manager this is called ‘Autostretch’, and is enabled by default, as seen by 
the tick box above the histogram (red square on below image). When autostretch is enabled, the scaling 

will automatically match to the max and min values, such as 93 and 1128 as seen on the previous histogram.  

 

If autostretch is disabled, the maximum and minimum will need to be manually set for each acquisition. If 
the light level or exposure time are changed, the signal intensity will also change and the histogram may 

go beyond the manual scaling points, so if deactivating autostretch please check your histogram and image 

each time you change anything that may affect signal level. 

 
As values of the very brightest and very darkest pixels can change rapidly, it is typical to ignore some 

percentage of the brightest and darkest pixels in determining image scaling. This is shown in 

Micro-Manager as the ‘Ignore %’ and typically defaults to 0.1%. This can be manually changed, but bear in 

mind a higher Ignore % as shown below (of 2% in this case), will result in a higher contrast image, but with 
more saturated pixels. The most important thing is to get the image that is most representative of your 

sample while also answering your scientific questions. 

 

  
 

It is possible to manually set the max and min display values by dragging the triangles on the top and 
bottom of the histogram respectively. Alternatively, double click on the min or max displayed value to 

type in a new value. For PVCAM cameras it is important to ensure that the lowest value is ~100, as this is 

the base level of offset in the camera settings. 
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Gamma 

The typical way to display image values is linearly, with min scaling value mapped to 0 display intensity, 

and a linear increase up to max scaling value mapping to 255. However, for some images such as thick 

samples in brightfield imaging, this can result in either poor contrast in dark areas or completely saturated 
bright areas. 

 

Gamma is a non-linear mapping of intensity values, meaning more display values can be used to give 

contrast to dark areas of the sample without saturating bright areas, and vice versa. To change gamma, 
click and drag the circle in the center of the line that connects the max and min display values on the 

histogram. 

 

Lookup tables (LUTs) 

Lookup-tables or LUTs apply false colors to image channels. The vast majority of scientific cameras are 

monochrome, meaning colors such as those seen in fluorescence are false colors applied after acquisition 

in order to differentiate between channels (such as DAPI being blue, etc.). 
 

Micro-manager comes with several LUT options for an alternative to the typical monochrome/greyscale 

appearance. In the above figure the image has a ‘Greyscale’ LUT, in the below figure ‘Fire’ is used. 

Different LUTs can help highlight small intensity differences in your image. 
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Scale Bars 
To display a scale bar in Micro-Manager, you will first need to set your Pixel Scaling Calibration, 

according to the instructions on Page 21. 

 

How to set up Scale Bars 
1. In the Inspector window under the Overlays tab, click the ‘+ Add’ button, and choose ‘Scale Bar’. 

 
 

2. Multiple options for length, thickness, color, label and position are then available. 
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Using ImageJ Functions & Plugins 
Some ImageJ analysis functions can be used on Micro-Manager images; however, some require the image 

to be brought explicitly across to a new instance of ImageJ. While Micro-Manager opens with an ImageJ 

window, this has limited functionality and lacks typical ImageJ Functions such as: 

 

• Plot Z Axis Profiles 

• Image summation & averaging 

• Use of ImageJ Plugins 

 

In order to access these and use the full suite of ImageJ analysis tools, you can open ImageJ from within 
Micro-Manager. This can be done by clicking the following option on the image window: 

 
 

Alternatively, you can manually open a new instance of ImageJ or Fiji, then open the image.  
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Live Analysis 
Micro-Manager and ImageJ has multiple plugins and functions for live, on-the-fly analysis as well as 

post-acquisition analysis. 

Line Profiles 
To draw a line profile in Micro-Manager, use the ImageJ Line tool and then in ImageJ choose ‘Analyze  

Plot Profile’. You can also use the keyboard shortcut ‘Ctrl + K’, although this shortcut will not work on a 

live updating image. 
 

You can click the ‘Live’ button on the graph window that appears to have the graph live update for either 

an updating image or for moving the line. 

 
You additionally have the option to thicken the line to take an average intensity measurement across the 

thickness of the line at each point along its length. To do this, double click the ImageJ line tool to specify 

line thickness. 

Intensity over time and ratiometric charts  
Micro-Manager can display live intensity charts for multiple regions of interest, on either a live view or an 

acquiring sequence, and display a ratiometric intensity of two ROIs, for applications such as Calcium 

imaging. 
 

Setting up Realtime Intensity Plots 

1. In Micro-Manager, choose ‘Plugins  Acquisition Tools  Realtime Intensity Plots’. 
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2. A window will appear asking you to set up ROI(s). You can do this using the ImageJ ROI Manager. 

3. To add an ROI to the manager, select your tool of choice (ROIs can be any shape) and draw an 

ROI, then press ‘Ctrl + T’ to add this to the Manager. You can repeat this for multiple ROIs. 

 
4. Once all of your ROIs are listed in the ROI Manager, the ‘Real time intensity GUI’ window should 

show ‘Ready’. Once you hit ‘Plot’, a live updating intensity window will appear once your display 
is updating with live data.  

5. To make a Ratiometric plot between ROIs numbered 1 and 2 in the ROI Manager, click ‘Settings’ 

in the ‘Real time intensity GUI’ and choose ‘Ratiometric image’. 
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Saving and Opening Acquired Data 
Files saved by Micro-Manager use the ome.tiff format, and can be universally opened in other imaging 

software, complete with metadata. However, Micro-Manager itself can only open files that were acquired 

using Micro-Manager. 

 
Whenever you ‘Snap’, ‘Album’ or use ‘Multi-Dimensional Acquisition (MDA)’ you can acquire an image, 

but this image needs to be saved to your storage drive if you want to open it later on. The method to save 

Micro-Manager files is given below. The alternative of saving via ImageJ’s ‘File  Save’ menus may not 

retain all metadata, and these files cannot be re-opened in Micro-Manager. Only by saving through the 
Micro-Manager window can you get the ome.tiff files for universal analysis. 

 

Saving acquired images to disk in MM 

1. To save an acquisition, click the Save 
icon to the bottom right of the 

image (red square). 

2. You will be prompted to choose 

between two saving methods: 
Image Stack Files or Separate 

Image Files. Image Stack Files are 

faster to work with and can be much 

more convenient than separate 
image files for large stacks.  

 

Note: Very large Image Stack Files 

are split into 4GB chunks according 
to the maximum size of a 

multi-page TIFF file. These will open 

as if they were one file. 

3. Files will save in a folder according 
to your file name.  

 

See below for some options relating 

to how files are saved. 
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Saving Options 

The ‘Tools  Options’ menu in Micro-Manager provides access to two saving-related settings: 

         
 

• ‘Sequence Buffer Size’ – determines how much RAM is allocated to store images before saving. 
If Micro-Manager is crashing during large acquisitions (1000s of frames) you may need to 

increase this. The value is MB so the 3000 MB in the example is only 3 GB of RAM. 

• ‘Create metadata.txt file with Image Stack Files’ –stores the image metadata separately, which 

provides easier access to post-acquisition analysis pipelines 

• ‘Save XY positions in separate Image Stack Files’ –separates XY stage positions in an acquisition 
into separate stack files. Note: Irrespective of this setting, when saving Separate Image Files, these 

files will be separated into folders according to XY stage position. 

 
Loading images saved from Micro-Manager 

1. Loading images can be done via 

Micro-Manager’s File menu.  

2. Either choose Virtual access where each 
frame/stack slice is loaded on demand from 

the hard drive, or RAM access where the 

entire image stack is pre-loaded into the 

RAM. RAM loading leads to faster image 
access, but large stacks will require large 

amounts of RAM. 

3. Alternatively, you can open files by dragging 

either the ome.tiff file or the folder 
containing it onto the Micro-Manager 

window. 

4. By default, this will load images into RAM, 

unless there is insufficient RAM in which 
case you will be prompted to open virtually 

instead. 

 

 

Drag & Drop 
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Streaming to RAM or Disk for High-Speed Imaging 
Acquiring and saving individual files or small stacks is easily done through Micro-Manager, whether using 

RAM or Disk. However, with larger and faster cameras continually in development, it is important to 

know the limitations of Micro-Manager when streaming data to RAM or Disk at high-speeds, working 

with large fields of view, or doing high-throughput imaging in general. 
 

This section mostly applies to our Kinetix sCMOS camera, which has a far higher speed and larger field of 

view than other scientific cameras, and consequently has a much higher data rate. 

 
The Kinetix has a 3200x3200 pixel array, meaning every acquired frame has a file size of 10 or 20 MB 

when using 8-bit or 12-/16-bit modes respectively. When using the 8-bit speed mode, the Kinetix can 

acquire 500 frames a second, and with each frame being 10 MB this results in a data rate of ~5 GB/s. 

When imaging close to or at this data rate, Micro-Manager can struggle. This section outlines how to 
stream to RAM or Disk at these high speeds when using Micro-Manager. 

 

Streaming to Disk 
12-bit 'Sensitivity' and 16-bit 'Dynamic Range' modes are able to stream at full speed to disk, allowing for 

constant acquisition as long as the disk still has capacity to store each frame.  

 
But due to limitations in the internal architecture of Micro-Manager, it currently isn't able to match the full 

speed of the Kinetix in 8-bit 'Speed' mode while streaming to disk. When testing computers (that met our 

specifications) for full-speed streaming to disk, our engineers have found a data rate limit of ~1.5-2 GB/s 

when writing to disk (the full data rate of the Kinetix in ‘Speed’ mode is 5 GB/s). In order to successfully 
stream to disk with a Kinetix at full speed when using Micro-Manager the data rate must therefore be 

limited, either by using regions of interest to reduce the frame size, or by reducing the frame rate by 

increasing exposure or using external hardware triggers. 

 
We are currently working on a solution to enable full-speed streaming to disk in Micro-Manager. In the 

meantime, for streaming to disk with a Kinetix in 8-bit 'Speed' mode, please contact us for an alternative 

free solution developed by Teledyne Photometrics. 

 

Streaming to RAM 
On a computer that meets our recommended specifications, Micro-Manager is capable of streaming to 

RAM (memory) at the full speed of the Kinetix in all modes. However, not all of your computer's RAM is 
available to Micro-Manager for acquisitions, typically ~40-50% of the available RAM is accessible. 

 

If using a computer with 64 GB of RAM, the Kinetix may be able to stream ~32 GB of data uninterrupted. 

If imaging at the full 500 fps speed of the Kinetix, at 10 MB per frame, this 32 GB of RAM represents 
~7 seconds of constant acquisition. If using the slower 12-bit 'Sensitivity' or 16-bit 'Dynamic Range' modes 

at 20 MB per frame, the 32 GB of RAM represents ~18 seconds of constant acquisition. 
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How to Stream to RAM at High-Speed with Micro-Manager 
 

Step 1: Installing the correct version of Micro-Manager 

Streaming to RAM will function optimally when using the latest nightly build of Micro-Manager 2.0.0 or 

2.0.1, please use a version dated from the 4th of March 2021 onwards. If you are constrained to use 
particular versions of micro-manager due to limited compatibility with other hardware, please contact us. 

 

Step 2: Installing the Kinetix into Micro-Manager 

For instructions on installing the Kinetix (or other high-speed PVCAM cameras) into Micro-Manager, 
please consult the relevant section of this guide on Page 9. 

 

Step 3: Setting the Sequence Buffer size 

Once you have Micro-Manager installed and your required 
hardware configured, there are a few settings to enable high 

speed acquisition to RAM. The first is the Sequence Buffer Size, 

found within Micro-Manager under Tools -> Options, 

highlighted in red as seen in the image to the right. 
 

The sequence buffer holds frames that come from the camera 

before they are copied to and processed by the Java 

environment (lmageJ). At its full field of view, the Kinetix is 
delivering frames to the buffer up to every 2 ms (at 500fps), but 

the copying to Java takes longer than this, so the sequence 

buffer will fill up while frames wait to be copied. 

 
The capacity of the sequence buffer can be set via 

Micro-Manager in the image shown. The default size of the 

buffer is 250 MB, and with single snaps or slower multi-D 

acquisitions the buffer is not used at all, with images copied to 
Java directly. 

 

To maximize the possible acquisition data size. the sequence 

buffer should be set to ~40-45% of available computer RAM. 
For a given acquisition size the sequence buffer should be set 

to a similar size. If your available PC RAM isn’t sufficient, the 

buffer can overflow and acquisition may fail, as seen in the 

error below. 
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Step 4: Setting the ImageJ Memory size 

After being stored in the sequence buffer within Micro-Manager, your images are copied to ImageJ for 

processing, displaying, or saving to disk. This means you also need to consider the memory size allocated 
to ImageJ itself. 

 

The memory size can be set via lmageJ -> Edit -> 

Options -> Memory & Threads, which opens the 
menu seen to the right. 

 

To maximize the possible data acquisition size. the 

lmageJ maximum memory should be set to 
~45-50% of the computer's RAM, similar to the 

amount allocated to the sequence buffer. 

 

With ~40% RAM allocated to the Micro-Manager 
sequence buffer, and ~40% RAM allocated to the 

ImageJ memory, your PC has 20% of its total RAM 

left for the operating system and any other open 

programs to run. 
 

To see how much RAM your computer is using, and what it is being allocated to, right-click the windows 

button and select ‘Task Manager’. There will be columns for CPU, Memory, Disk and Network. The 

‘memory’ column is your computers RAM, and the percentage shows how much of it is in use. If more 
than 20% of your RAM is being used before you even open Micro-Manager, you may need to close some 

programs, especially RAM-hungry programs like Google Chrome. 

 

If you don’t know how much RAM your computer has, click the ‘Performance’ tab within the Task Manager 
and go to ‘Memory’, this will show you how much memory you have, and what is currently in use. 
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Step 5: Running an Acquisition 

Set up your experiment in Micro-Manager as 

normal. When setting up your large acquisition 
through the Multi-Dimensional Acquisition 

window you will see the ‘total memory’ for the 

acquisition updating as you fill in the fields. 

 
For example, in the right image, this acquisition 

will require ~8.8 GB of memory. This should be 

less than the memory given to ImageJ in step 

4, and roughly the same as the sequence buffer 
size given to Micro-Manager in step 3. 

 

 

 
 

 

 

 
 

 

 

 
 

 

 

 

Monitoring Image Acquisition 
If you are acquiring at high speed, the sequence buffer is expected to fill up very quickly. This can be 
monitored via Micro-Manager -> Plugins -> Developer Tools -> Sequence Buffer Monitor, as shown 

Below in the left-hand image. This should not reach 100% during acquisition. 

 

Java memory utilization can also be monitored: lmageJ -> Plugins -> Utilities -> Monitor Memory, 
shown below in the right-hand image. Similarly, this should stay below 100%. 

 

 
 

 



 

 

 
 

Rev A4      ©2023 Photometrics. All rights reserved.  

How to use Micro-Manager 
 

 

46 

 

Checking that the acquisition completed successfully 

Once an acquisition has completed, select the Inspect window in Micro-Manager and open the 

'Image Plane Metadata' section, as shown below. 
 

The total frame values in ‘PVCAM-FMD-FrameNr’ and ‘PVCAM-FrameNr’ should be the same. This should 

also be one greater than the ‘lmageNumber’, as the first frame has a lmageNumber of 0. 

 
If the metadata frame numbers are larger than your requested number of frames, frames were acquired by 

the camera that the computer was not able to record, and those frames are lost. To avoid frame losses, 

you may need to reduce the total acquisition size or reduce the acquisition speed or data rate. 
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